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Requirements
This exercise requires a PC running Windows 95/98, NT/2000/XP, with ArcView 3.x including the projection utility. 
Internet access is needed. The necessary data are provided.

Objectives
The objective of this exercise is to gain a basic understanding of map projections, and how a projection affects the 
result of a GIS analysis. After completing this exercise, trainees will be able to: 

Understand the basic principles of map projections;•	
View different map projections of the same land area;•	
Change the map projection of a data layer;•	
Recognize the distortion associated with selected map projections;•	
Select the appropriate projection for specific GIS analysis objectives.•	
Find useful scripts on the internet and expand the functionality of ArcView.•	

Task
Locate an avenue script that calculates the area of a polygon and add a button to the interface that executes this 
script.

Prepare a set of layouts showing the world, Africa, and the Lake Victoria area in various map projections. Select 
the proper projection 

Introduction

Introduction
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Preparation

Before starting with the projection exercise, we will add a new function to calculate the area of a polygon. Projections 
affect the distortion of area, scale, local shape, direction, and distance. The new area calculation function will help in 
assessing the distortion associated with various projections.

Find script to calculate the area of a polygon.
In this exercise we will explore the online support offered by ESRI to expand the functionality of ArcView, and to tap 
into a global network of GIS tool and script developers.

Open Internet Explorer  and browse to www.esri.com.

Select “Support”; spend ten minutes to check out the “Knowledge Base” and “User forum” topics.  Go back to 
“Support” => “Downloads” => “ArcScripts”.

Preparation

Select “ArcView GIS” in the search 
interface. Type an appropriate query 
in the “search for” text box, e.g. “Area 
Calculation”. Activate search by clicking 
the “search” button.

The first 10 results are shown. Select an appropriate script; in this particular case “Area Calculation for Polygon”. 
Double click and read the script summary; download the file to C:\GIS_Work\GISWS\ExProj\AvScript. Upzip the file. 
This is an avenue script file named “area.ave”..

Open ArcView  and select Scripts  from the project 
window. Click “New” to begin a new script. 

In the “Script” menu, select “Load Text File”. Navigate to the 
appropriate folder and select “area.ave”.

Change the name of the script. Select “Properties” in the 
“Script” menu, and type “Area.Calc” in the “Name” text 
box.

Compile the “Area.Calc” script by clicking the compile 
button;  the resulting window is shown below.
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Preparation

Leave the script area to return to the project window.

Add a new button to the ArcView interface.
In this exercise we will add a new button to the ArcView interface and connect it to the area calculation script.

Select Views,  and open a new view. Double click the menu/toolbar area. The following window appears.

From the drop down list in the “Category” box, 
select “Buttons”.

All elements of the current button bar are 
presented. Move the slide bar to its most 
rightward position.

Click the separator button  to add a 
space; then click the “new” button. A new blanc 

button  is added.

We proceed by setting the properties of this new button, and connect it to the Area.Calc script.
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Preparation

Click the button just added. Its attributes are 
shown in the window on the left. As you can 
see, no instructions are connected to the “click” 
attribute; its field to the right is empty.

Double click this field; it is indicated with an 
arrow.

The script manager appears. Select the Area.

Calc script and click OK.  The text in the 
function field has now changed to Area.Calc.

Next we will add an icon to the new button. Double 
click the field next to “Icon”, which now shows 
“empty”. This activates the “Icon Manager”, 
shown on the left

Select A for area, click OK  

This step concludes setting the properties of 
the new button. The   button is now added to the 
interface and operational; it will calculate the 
area of a selected polygon.

Save the project if you want to keep the new interface.

Before starting with the projection exercise, go back to the ArcScript web page and spend some time checking for 
useful ArcView script that can expand the functionality of this package for water resources assessment, planning, 
and management purposes. 
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Map Projections of the World
Selecting a map projection is all about managing distortions. The choice of a particular projection depends on the 

objective of the user. Does he want to calculate an accurate area, or is she more interested in a proper reflection of 
the local shape of the geographic object.

Projections affect five types of distortions: area, scale, local shape, direction, and distance. This is illustrated by 
the figures below:

Procedure

Procedure

The first figure presents the original square. Angles between horizontals and verticals are 90 degrees. The paral-
lels AC and DB are identical in length and perpendicular. 

A different projection leads to ‘square’ number two, with the following distortions: 

Distance: A’D’  C’B’•	
Scale: A’B’  C’D’•	
Direction: vector D’B’ no longer coincides with the right edge of the box•	
Local shape: no 90•	 0 angles between horizontal and vertical box edges
Area: implied by 1 & 2•	

Conformal projections preserve local shape. All angles between arcs are preserved, including those between 
intersecting arcs.

Equal area projections maintain the area of the geographic object. Shape, angle, scale, or any combination of this 
may be distorted.

True equidistant projections do not exist. Scale is not maintained correctly by any projection through the entire 
map. However, there may be lines for which scale is maintained correctly.

True direction projections correctly represent the shortest route between two points.
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Project the world in the three major projection classes
Major projection classes are cylinder, cone, and plane.

Activate ArcView  and open a new view . Add the “Continent.shp” and “Wldgrd05.shp” layers. Data are 
stored in the “ExProj” folder. Select “Properties” from the “View” menu. 

The properties box, presented on the left, 
appears. Click the Projection  
button.

Let’s check out the planar projection class 
first. 

The planar projection projects data onto a 
flat surface touching the globe.

This projection is also referred to as 
Azimuthal.

The connection point of this plane to the earth determines if we have a polar, equatorial, or oblique Azimuthal 
projection, as shown below.

Azimuthal projections include Gnomonic, Stereographic, and Orthographic, which have different focus points.

Procedure
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Exercise: Present the world in Gnomonic, Stereographic, and Orthographic projections. Check the various distor-
tions around the pole and the equator. What is the point of least distortion?

Select the proper projection in the drop 
down list. Set the Central Meridian to 0, 
and the Reference Latitude to 90.

Present the world in Gnomic, 
Stereographic, and Orthographic 
projection.

Next, repeat the exercise with focus 
on Africa: Central Meridian = 20, and 
Reference Latitude = 0.  

We will continue with the Cylindrical projection. Two important members of this class are the Mercator (Normal 
Cylindrical) and UTM (Traverse Cylindrical), both presented below. 

Procedure
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Mercator has a line of no-distortion (called Standard Line) around the equator; areas close to the poles are expe-
riencing significant distortion.

Exercise: present the world in Mercator projection.

Universal Transverse Mercator (UTM) is the de facto world standard for topographic mapping. About 85% of the 
land area in the world uses this projection. 

UTM divides the world in 60 longitudinal zones of 6•	 0 each, starting at -1800, annotated zone 1;
UTM makes a latitudinal division into 8•	 0 intervals.
Each zone has its own coordinate system.•	
UTM is inappropriate for large areas, since the area to be mapped has to be part of one UTM zone.  •	

World UTM zones are depicted in the following figure.

Procedure
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Exercise: select the proper UTM zone for the Lake Victoria region.  

Open a new view  and add the “Continent.shp”. We will use a map query to create a new layer containing the 
African continent. Select “Query” from the “Theme” menu.

Build the appropriate query. Double 
click “Continent” from the field list. 

Click the “=” sign , then double 
click “Africa”. The query window is 
presented on the left. 

Click “New Set” 

Activate the View window.

Africa is marked yellow, indicating it has been selected, as shown below.

Create the new shape file. To this 
end, select “Convert to Shape File” 
from the “Theme” menu.

Navigate to the “ExProj” folder and 
name the new shape “Africa.shp”.

Click OK.  The new shape 
file is generated.

Close the Query box and remove the “Continent.shp”. To this end, activate this layer and select “Delete Themes” 
from the “Edit” menu.

Add the following layers to the view: “Afgrd02.shp”, “Lakevic.shp”, and “Africa.shp”, which should all be available 
in the “ExProj” folder. The resulting view is presented below.

Select the proper UTM zone for the Lake Victoria Area, and project the view in this projection.

Procedure
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Select “Properties” from the 
“View” menu.

Click the Projection button. 

Select “UTM – 1983” and set 
the appropriate zone. Click OK . 

Set the Map Units to kilometers

The result is shown below.

Try out various UTM zones and check the 
difference. Zoom in to the Lake Victoria to see 
how the graticule changes.

We continue with the last projection class: Conical. 

Two important members of this family are “Normal Conical” and “Secant Normal Conical”, both presented 
below.

Normal Conical. Secant Normal Conical.

Procedure
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The Normal Conical is tangent to the globe along a line of latitude. This line is called the “Standard Parallel” and 
represents the line of no distortion. The meridians are projected onto the conical surface, meeting at the apex of the 
cone. Parallel lines of latitude are projected as rings. 

The Secant Normal Conical intersects the globe at two locations, and is thus defined by two Standard Parallels. 
Generally, a Secant Normal Conical projection has less distortion than a Normal Conical.

Conical projections are predominantly used for the temperate latitudes. A well know member of this class is the 
“Albers Equal Area” projection.

Exercise: present the Africa shape and grid in the Albers Equal Area projection. The result is shown below.

Adjust the Standard Parallels to 
facilitate accurate calculation 
of the surface area of the Lake 
Victoria.

Spend some time experimenting.

Select a proper projection and calculate the surface area of Lake Victoria
The next exercise is to calculate the surface area of the Lake Victoria for various projections. Select an appropriate 
Planar, Conical, and Cylindrical projection with minimal distortion of area in the equatorial regions. Then use the 
Area.Calc script to calculate the surface area.

This Area.Calc script adds a column to the attribute table. To avoid corrupting the original layer, copy the LakeVic.
shp to a new coverage, and use this coverage file for the area assessment.

Each spatial layer consists of a number of files, ranging from 3 to 7. One has, therefore, to be cautious when 
copying a layer. Forgetting a file may result in loosing projection or geo-referencing. A convenient tool for managing 
spatial layers is the “Source Manager” included in ArcView.

Select “Manage Data Sources…” from the “File” menu.

Procedure
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This activates the “Source 
Manager”, shown on the left.

Navigate to the “ExProj” folder 
and select the LakeVic.shp file. 
Click Copy  and select a 
name (e.g. “LV.shp”) and location 
for the file. 

Click OK  to finish.

Close “Source Manager

Add the new shape to the view.

Exercise: select a proper projection to calculate the surface area of Lake Victoria.

Set the appropriate projection. Make sure to define the proper map units. 

Activate the new layer (i.e. 
LV.shp)

Then click  to open the 
attribute table. Select the Lake 
Victoria polygon. 

The result is shown on the left.

Click the A  button to calculate the area of the selected polygon. Compare the surface area calculated with a 
Planar, Cylindrical (UTM), and Conical projections. For the latter, use Albers Equal Area. While analyzing the results, 
please keep in mind that the Lake Victoria islands were removed from the polygon. 

Use the Projection Utility.
Use the Projection Utility to permanently change the projection of a shape file. If you are dealing with an ARC/INFO 
coverage, first transfer it to a shape file. 

Procedure
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Browse to “Start” => “Programs” => “ESRI” => “ArcView GIS 3.2” and 
select “Projection Utility” from the menu options, as shown on the 
left.

The ArcView projection utility is a wizard-based tool that allows you to 
project shape files, either from geographic coordinates to projected 
coordinates, or from one projection to the other. The utility also 
facilitates to convert the datum of your shape files.

Exercise: Change the projection of the LV.shp file to UTM zone 35, WGS 84 datum.

After activating the wizard, follow the 
instructions on screen. 

Click Browse  to select 
the “LV.shp” file. 

Define the current projection. Set the 
datum to GCS_WGS_1984.

Click Next  

Procedure
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Select the new projection. 
Activate the “Projected” radio 
button in the “Coordinate System 
Type” box.

Select the appropriate UTM 
projection. Make sure to use 
WGS_1984.

Set the units to meters.

Click Next  

Select a name and folder for the new shape file. Click Next. A summary window appears.

Check the input and output 
variables.

If correct, click Finish .

The new shape file is generated in the 
requested projection. Completion is 
indicated by the following message: 

Open new View, add the new shape file, and check results.

This completes today’s exercises and course work. Projections are now demystified!

Reference
ESRI Digital Document: Understanding_Map_Projection.pdf

Procedure


